
Chipsmall Limited consists of a professional team with an average of over 10 year of expertise in the distribution

of electronic components. Based in Hongkong, we have already established firm and mutual-benefit business

relationships with customers from,Europe,America and south Asia,supplying obsolete and hard-to-find components

to meet their specific needs.

With the principle of “Quality Parts,Customers Priority,Honest Operation,and Considerate Service”,our business

mainly focus on the distribution of electronic components. Line cards we deal with include

Microchip,ALPS,ROHM,Xilinx,Pulse,ON,Everlight and Freescale. Main products comprise

IC,Modules,Potentiometer,IC Socket,Relay,Connector.Our parts cover such applications as commercial,industrial,

and automotives areas.

We are looking forward to setting up business relationship with you and hope to provide you with the best service

and solution. Let us make a better world for our industry!

Contact us
Tel: +86-755-8981 8866 Fax: +86-755-8427 6832

Email & Skype: info@chipsmall.com Web: www.chipsmall.com

Address: A1208, Overseas Decoration Building, #122 Zhenhua RD., Futian, Shenzhen, China

    



 2012 Microchip Technology Inc. DS41629A

F1 LV Evaluation Platform

Motor Control Add-Ons

User’s Guide



DS41629A-page 2  2012 Microchip Technology Inc.

Information contained in this publication regarding device

applications and the like is provided only for your convenience

and may be superseded by updates. It is your responsibility to

ensure that your application meets with your specifications.

MICROCHIP MAKES NO REPRESENTATIONS OR

WARRANTIES OF ANY KIND WHETHER EXPRESS OR

IMPLIED, WRITTEN OR ORAL, STATUTORY OR

OTHERWISE, RELATED TO THE INFORMATION,

INCLUDING BUT NOT LIMITED TO ITS CONDITION,

QUALITY, PERFORMANCE, MERCHANTABILITY OR

FITNESS FOR PURPOSE. Microchip disclaims all liability

arising from this information and its use. Use of Microchip

devices in life support and/or safety applications is entirely at

the buyer’s risk, and the buyer agrees to defend, indemnify and

hold harmless Microchip from any and all damages, claims,

suits, or expenses resulting from such use. No licenses are

conveyed, implicitly or otherwise, under any Microchip

intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC, 

KEELOQ, KEELOQ logo, MPLAB, PIC, PICmicro, PICSTART, 

PIC32 logo, rfPIC and UNI/O are registered trademarks of 

Microchip Technology Incorporated in the U.S.A. and other 

countries.

FilterLab, Hampshire, HI-TECH C, Linear Active Thermistor, 

MXDEV, MXLAB, SEEVAL and The Embedded Control 

Solutions Company are registered trademarks of Microchip 

Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, chipKIT, 

chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net, 

dsPICworks, dsSPEAK, ECAN, ECONOMONITOR, 

FanSense, HI-TIDE, In-Circuit Serial Programming, ICSP, 

Mindi, MiWi, MPASM, MPLAB Certified logo, MPLIB, 

MPLINK, mTouch, Omniscient Code Generation, PICC, 

PICC-18, PICDEM, PICDEM.net, PICkit, PICtail, REAL ICE, 

rfLAB, Select Mode, Total Endurance, TSHARC, 

UniWinDriver, WiperLock and ZENA are trademarks of 

Microchip Technology Incorporated in the U.S.A. and other 

countries.

SQTP is a service mark of Microchip Technology Incorporated 

in the U.S.A.

All other trademarks mentioned herein are property of their 

respective companies.

© 2012, Microchip Technology Incorporated, Printed in the 

U.S.A., All Rights Reserved.

 Printed on recycled paper.

ISBN: 9781620761236

Note the following details of the code protection feature on Microchip devices:

� Microchip products meet the specification contained in their particular Microchip Data Sheet.

� Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 

intended manner and under normal conditions.

� There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 

knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 

Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

� Microchip is willing to work with the customer who is concerned about the integrity of their code.

� Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our

products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts

allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2009 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT  SYSTEM 

CERTIFIED BY DNV 

== ISO/TS 16949 == 



F1 LV EVALUATION PLATFORM

MOTOR CONTROL ADD-ONS

 2012 Microchip Technology Inc. DS41629A-page 3

Table of Contents

Chapter 1. F1 LV Evaluation Platform Overview

1.1 Introduction ............................................................................................. 13

1.2 Hardware Overview ................................................................................ 13
1.2.1 Evaluation Platforms .............................................................................. 13

1.2.2 Add-on Boards ....................................................................................... 13

1.2.3 USB Interface ........................................................................................ 14

1.2.4 Add-on Board Power ............................................................................. 14

1.2.5 Add-on Board Memory .......................................................................... 14

1.3 PC Software Overview ........................................................................... 14

1.4 Using the F1LVDemo Control Software ................................................. 17
1.4.1 Software Updates .................................................................................. 17

1.4.2 Serial Link .............................................................................................. 17

1.4.3 Connecting the F1 LV Evaluation Platform to the Add-on Board .......... 17

1.4.4 Connecting the F1 LV Evaluation Platform to the PC ............................ 17

1.4.5 Open Versus Closed Loop .................................................................... 18

1.4.6 Changing Motor Parameters ................................................................. 18

1.4.7 Saving and Restoring Motor Parameters .............................................. 18

1.4.8 Hints for Optimum Performance ............................................................ 19

1.4.9 Header File Versus GUI Motor Parameters ........................................... 19

Chapter 2. The BLDC Add-on Board

2.1 Overview ................................................................................................. 21
2.1.1 Features ................................................................................................ 21

2.1.2 What’s Included ..................................................................................... 21

2.1.3 Reference Documents ........................................................................... 22

2.2 Board Setup ............................................................................................ 22

2.3 Hardware ................................................................................................ 22
2.3.1 General Architecture .............................................................................. 22

2.3.2 Attaching the Motor ............................................................................... 23

2.3.3 Power-Up ............................................................................................... 23

2.3.4 Power Stage .......................................................................................... 23

2.3.5 Protection .............................................................................................. 24

2.3.6 Speed Control ........................................................................................ 24

2.4 Demo Software ....................................................................................... 24
2.4.1 Introduction ............................................................................................ 24

2.4.2 The Motor Control GUI Application ........................................................ 24

2.4.3 BLDC Parameter Optimization .............................................................. 25

Chapter 3. The Brushed DC Add-on Board

3.1 Getting Started ....................................................................................... 29
3.1.1 Overview ................................................................................................ 29

3.1.2 Features ................................................................................................ 29

3.1.3 What’s Included ..................................................................................... 29



F1 LV Evaluation Platform Motor Control Add-Ons

DS41629A-page 4  2012 Microchip Technology Inc.

3.1.4 Reference Documents ...........................................................................30

3.2 Board Setup ............................................................................................ 30

3.3 Hardware ................................................................................................ 30
3.3.1 General Architecture ..............................................................................30

3.3.2 Attaching the Motor ................................................................................31

3.3.3 Power-Up ...............................................................................................31

3.3.4 Power Stage ..........................................................................................31

3.3.5 Protection ...............................................................................................32

3.3.6 UNI/O® Memory Chip .............................................................................32

3.3.7 Speed Control ........................................................................................32

3.4 Demo Software ....................................................................................... 32
3.4.1 Introduction ............................................................................................32

3.4.2 The Motor Control GUI Application ........................................................32

Chapter 4. The Bipolar Stepper Add-on Board

4.1 Getting Started ....................................................................................... 33
4.1.1 Overview ................................................................................................33

4.2 Features ................................................................................................. 33
4.2.1 What’s Included .....................................................................................33

4.2.2 Reference Documents ...........................................................................33

4.3 Getting Started ....................................................................................... 34

4.4 Hardware ................................................................................................ 34
4.4.1 General Architecture ..............................................................................34

4.4.2 Attaching the Motor ................................................................................35

4.4.3 Power-Up ...............................................................................................35

4.4.4 Power Stage ..........................................................................................35

4.4.5 Protection ...............................................................................................36

4.4.6 UNI/O® Memory Chip .............................................................................36

4.4.7 Speed Control ........................................................................................36

4.4.8 Current Control ......................................................................................36

4.5 Demo Software ....................................................................................... 37
4.5.1 Introduction ............................................................................................37

4.5.2 The Motor Control GUI Application ........................................................37

4.6 Optimizing Stepper Motor Parameters ................................................... 38
4.6.1 Stepper Motor Closed-Loop Drive Overview .........................................38

4.6.2 Optimizing DUTY_SCALE and SPEED_SCALING_CONST .................39

Chapter 5. The Unipolar Stepper Add-on Board

5.1 Getting Started ....................................................................................... 41
5.1.1 Overview ................................................................................................41

5.1.2 Features .................................................................................................41

5.1.3 What’s Included .....................................................................................41

5.1.4 Reference Documents ...........................................................................42

5.2 Getting Started ....................................................................................... 42

5.3 Hardware ................................................................................................ 42
5.3.1 General Architecture ..............................................................................42

5.3.2 Attaching the Motor ................................................................................43

5.3.3 Power-Up ...............................................................................................43

5.3.4 Power Stage ..........................................................................................43

5.3.5 Protection ...............................................................................................44



 2012 Microchip Technology Inc. DS41629A-page 5

5.3.6 UNI/O® Memory Chip ............................................................................ 44

5.3.7 Speed Control ........................................................................................ 44

5.3.8 Current Control ...................................................................................... 44

5.4 Demo Software ....................................................................................... 45
5.4.1 Introduction ............................................................................................ 45

5.4.2 The Motor Control GUI Application ........................................................ 45

5.5 Optimizing Stepper Motor Parameters ................................................... 46
5.5.1 Stepper Motor Closed-Loop Drive Overview ......................................... 46

5.5.2 Optimizing DUTY_SCALE and SPEED_SCALING_CONST ................ 47

Appendix A. Board Layout and Schematics

A.1 Introduction ............................................................................................. 49

Appendix B. Conversion Factors

B.1 Conversion Factor Derivations ............................................................... 55

B.2 Start-up: Speed ...................................................................................... 55

B.3 Slow Step ............................................................................................... 55

B.4 Stepper Run and Stop Percentages ....................................................... 56

B.5 Degrees Per Step ................................................................................... 56

B.6 Stepper: Min and Max Duty Percent ....................................................... 56

B.7 Constants Derived From Stepper Parameters ....................................... 56
B.7.1 DUTY_SCALE Constant ........................................................................ 56

B.7.2 SPEED_SCALING_CONST Constant ................................................... 57

B.8 uStep Table ............................................................................................ 57



F1 LV Evaluation Platform Motor Control Add-Ons

DS41629A-page 6  2012 Microchip Technology Inc.

NOTES:



 2012 Microchip Technology Inc. DS41629A-page 7

F1 LV EVALUATION PLATFORM

MOTOR CONTROL ADD-ONS

Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

F1 LV Evaluation Platform Motor Control Add-ons User’s Guide. Items discussed in this 

chapter include:

� Document Layout

� Conventions Used in this Guide

� Warranty Registration

� Recommended Reading

� The Microchip Web Site

� Development Systems Customer Change Notification Service

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This document describes how to use the F1 LV Evaluation Platform Motor Control 

Add-ons User’s Guide as a development tool to emulate and debug firmware on a 

target board. The manual layout is as follows: 

� Chapter 1. “F1 LV Evaluation Platform Overview” 

� Chapter 2. “The BLDC Add-on Board”

� Chapter 3. “The Brushed DC Add-on Board”

� Chapter 4. “The Bipolar Stepper Add-on Board”

� Chapter 5. “The Unipolar Stepper Add-on Board”

� Appendix A. “Board Layout and Schematics”

� Appendix B. “Conversion Factors”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 

Sending in the Warranty Registration Card entitles users to receive new product 

updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the F1 LV Evaluation Platform Motor Control 

Add-ons User’s Guide. Other useful documents are listed below. The following Micro-

chip documents are available and recommended as supplemental reference 

resources.

Readme for F1 LV Evaluation Platform Motor Control Add-ons User’s Guide

For the latest information on using F1 LV Evaluation Platform Motor Control Add-ons 

User’s Guide, read the “Readme for F1 LV Evaluation Platform Motor Con-

trol Add-ons User’s Guide.txt” file (an ASCII text file) in the Readmes subdi-

rectory of the MPLAB IDE installation directory. The Readme file contains update 

information and known issues that may not be included in this user’s guide.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in 

the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files 

contain update information and known issues that may not be included in this user’s 

guide.
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers – The latest information on Microchip C compilers and other language 

tools. These include the HI-TECH C® C16, MPLAB C18 and MPLAB C30 C com-

pilers; MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB 

LINK30 object linkers; and MPLIB™ and MPLAB LIB30 object librarians.

� In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debugger, MPLAB ICD 2, MPLAB ICD 3, PICkit™ 3.

� MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 

and general editing and debugging features.

� Programmers – The latest information on Microchip programmers. These include 

the MPLAB PM3 device programmers and PICkit™ 3 development programmers.



Preface

 2012 Microchip Technology Inc. DS41629A-page 11

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (March 2012)

� Initial Release of this Document.
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Chapter 1.  F1 LV Evaluation Platform Overview

1.1 INTRODUCTION

This user’s guide offers a quick start-up and eventual troubleshooting for the motor 

control add-ons used together with the F1 LV Evaluation Platform. For more details 

regarding the supported applications, control algorithms, hardware and software sup-

port, please visit the reference sections inside this user’s guide.

1.2 HARDWARE OVERVIEW

1.2.1 Evaluation Platforms

The F1 Evaluation and F1 LV Evaluation Boards are stand-alone evaluation platforms 

for investigating the capabilities of the PIC16(L)F1XXX family of devices. F1 is an 

abbreviation for all PIC® microcontroller devices with the notation “F1” in the device 

number. All F1 devices are enhanced mid-range devices. Only enhanced mid-range 

devices have the F1 notation.

There are two development boards for evaluating the F1 devices:

� F1 Evaluation Platform with 44-pin PIC16LF1937 microcontroller

� F1 LV Evaluation Platform with 64-pin PIC16LF1947 microcontroller

This document refers primarily to the F1 LV Evaluation Platform.

The F1 LV Evaluation Platform is the second generation evaluation platform for the 

enhanced mid-range devices with more I/O pins and expanded capability. For more 

information about the F1 LV Evaluation Platform refer to DS41614, “F1 LV Evaluation 

Platform for Enhanced PIC® Microcontrollers User’s Guide”.

1.2.2 Add-on Boards

Four motor control add-on boards are available for use in conjunction with the F1 LV 

Evaluation Platform. This document describes those boards and the companion control 

software for evaluating and optimizing motor control. The four motor control boards 

include:

The software and hardware interface of the F1 Evaluation Board supports only the 

BLDC Add-on Board. The software supplied and preloaded on the F1 LV Evaluation 

Platform supports all four of the add-on boards.

TABLE 1-1:

Motor Type ID Shown on Platform LCD Part Number F1 LV Eval F1 Eval

Brushless DC bldc DM164130-2 Yes Yes

Brushed DC bdc DM164130-6 Yes No

Bipolar Stepper bstp DM164130-7 Yes No

Unipolar Stepper ustp DM164130-8 Yes No
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1.2.3 USB Interface

The F1 LV Evaluation Platform includes a USB to serial interface. This provides the 

capability to control the motors in real time without entering Debug mode. PC control 

software communicates with the F1 LV Evaluation Platform software to create an inte-

grated motor control evaluation system. The PC software and interface driver are avail-

able for free download from the Microchip web site at www.microchip.com/F1Eval.

1.2.4 Add-on Board Power

When using an add-on board, the F1 LV Evaluation Platform power should be supplied 

from the add-on board. The J6 jumper option makes this connection. There is no 

jumper option to supply power to the add-on board from the F1 LV Evaluation Platform, 

because most of the platform power options do not have sufficient capacity. When 

power is applied to the F1 LV Evaluation Platform through the add-on board, then the 

UNI/O® memory is detected and read. The F1 LV Evaluation Platform software config-

ures itself to operate the motor identified in the memory. This automatic configuration 

also applies to the PC control software.

1.2.5 Add-on Board Memory

Every add-on board, with one exception, includes a UNI/O memory device that con-

tains: 

� board ID 

� board revision

� parameters associated with the motor supplied with the add-on board

When the F1 LV Evaluation Platform senses that an add-on board is attached, the initial 

display shows the motor type and add-on board revision. Motor speed can be con-

trolled with either the potentiometer on the F1 LV Evaluation Platform or with the PC 

interface speed control. Additional motor capabilities are available through the PC con-

trol interface. These are described in more detail in the sections specific to each motor.

The first generation BLDC boards do not have a UNI/O memory. When the F1 LV 

Evaluation Platform does not detect a UNI/O memory, it then checks voltages on other 

selected J3 connections to determine if a BLDC circuit is present. When a BLDC board 

without UNI/O memory is detected, the motor parameters are then retrieved from the 

F1 LV Evaluation Platform EEPROM memory. The factory defaults for these parame-

ters match those needed for the motor originally supplied with the BLDC board. If the 

parameters are modified for another motor, then the File->RAM->EEPROM option will 

save those parameters to the F1 LV Evaluation Platform EEPROM memory in lieu of 

the UNI/O memory.

The advantage that the UNI/O equipped boards have is that several different add-on 

boards can each support and remember the settings for a different motor. Various 

BLDC motors can be accommodated when working with the first generation BLCD 

Add-on Board, by saving and recalling the motor parameters to and from the PC disc 

storage with the File->Save… and File->Open… options.

1.3 PC SOFTWARE OVERVIEW

The F1LVDemo software is a Graphical User Interface (GUI) providing control of the 

motor speed and direction. The GUI also provides access to key parameters of the 

motor operation. The control parameters vary by motor type. Each parameter and 

method of optimization are described in detail in the motor sections of this document.

Figure 1-1 and Figure 1-2 show the front panel of the PC control GUI. Features of the 

control GUI are identified and described below.
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FIGURE 1-1:
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1. Motor Parameters pull-down menu. Save 

and recall to and from disc.

2. Speed control (relative 0 to 255):

� Commutation rate in open loop

� Drive level in closed loop

3. Zero cross advance/retard (BLDC only).

4. Motor drive voltage control (open loop). In 

BLDC closed loop this control reverts to a 

balance control.

5. BLDC open-loop single-step button.

6. Open/closed-loop control selection (BLDC 

and stepper motors only).

7. Panic STOP button – Forces drive and com-

mutation to zero.

8. Motor direction selection.

9. Number of motor poles (BLDC only).

10. Serial port selection.

11. Serial link Open/Close button.

12. Motor type indicator.

13. Motor RPM – click label to update.

14. Initial drive level for start-up.

15. Initial speed setting for start-up.

16. PC Software version.

17. F1 LV Evaluation Platform software version.

18. Run time and static motor parameters tabs.
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FIGURE 1-2:
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19. BLDC flyback voltage blanking time.

20. BLDC dwell time at each start-up step.

21. BLDC milliseconds to remain in Open-Loop 

mode at start-up before closing the loop.

22. BLDC minimum commutation time below 

which a stall is detected.

23. BLDC error feedback multiplication factor. 

Each shift divides error by 2.

24. Stepper motor steps in each drive phase 

when microstepping is selected.

25. Button to invoke new microstep sinusoid 

drive look-up table.

26. Peak drive level in microstep look-up table.

27. Stepper motor commutation mode selec-

tion.

28. Stepper motor maximum RPM commutation 

rate when speed control is set at maximum. 

29. Degrees per step physical attribute of the 

attached motor.

30. Maximum drive voltage duty cycle applied 

when speed control is at the maximum 

RPM. This prevents excessive overdrive of 

the motor.

31. Stepper motor drive voltage duty cycle 

applied when speed control is at the lowest 

run speed above stop.

32. Percent of speed control setting, relative to 

maximum, below which the motor drive is 

removed and the motor is stopped.

33. Percent of speed control setting, relative to 

maximum, above which the motor starts 

from a stopped state.
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1.4 USING THE F1LVDEMO CONTROL SOFTWARE

1.4.1 Software Updates

The software supplied and preloaded into the F1 LV Evaluation Platform supports all 

four of the add-on motor control boards. The preloaded software is the latest version 

available at time of manufacture. Source code including any updates is available for 

free download from the Microchip web site: www.microchip.com/F1Eval.

All motors can be controlled with the PC-based F1LVDemo control GUI. The 

F1LVDemo control software is available for free download from the Microchip web site: 

www.microchip.com/F1Eval.

1.4.2 Serial Link

The F1LVDemo control GUI operates through a USB to serial interface that appears as 

a standard RS-232 serial port to the PC operating system. The USB interface on the 

F1 LV Evaluation Platform is an MCP2200 USB to Serial interface device. Ensure that 

the drivers for this interface are loaded in the PC before making the connection. Inter-

face drivers can be downloaded for free from the MCP2200 product page of the Micro-

chip web site.

1.4.3 Connecting the F1 LV Evaluation Platform to the Add-on Board

Perform the following steps in the order shown to establish the link between the 

F1LVDemo control software and the F1 LV Evaluation Platform.

1. Connect the desired add-on board to the F1 LV Evaluation Platform J3.

2. Connect the supplied motor to the add-on board.

3. Ensure the following jumpers are in place on the F1 LV Evaluation Platform:

� J10 – Pot Enable

� J9 – Temperature Sense Enable

� J4 – I Sense break

� J6 – Expansion Board Power

4. Turn the RF2 potentiometer fully counter clockwise.

5. Each add-on board is equipped with a linear 3.3 Volt regulator that supplies 

power to the F1 LV Evaluation Platform. 

Apply 9-12 VDC power to the add-on board. Power can be applied through the black 

2.5 mm power jack or directly to the appropriate pins of the add-on board motor con-

nector. The power jack connector is designed to accept 9 VDC, 0.75 amp wall trans-

former. The center pin is the positive terminal. When power is applied the F1 LV 

Evaluation Platform LCD will display the motor type and add-on board revision.

At this point the motor can be operated stand-alone with the potentiometer on the F1 

LV Evaluation Platform. Additional motor controls are accessible only with the control 

GUI.

1.4.4 Connecting the F1 LV Evaluation Platform to the PC

6. Connect a USB cable from the PC to the F1 LV Evaluation Platform J2.

7. Execute the F1LVDemo program.

8. Select the communication port associated with the F1 LV Evaluation Platform. 

This will most likely be the highest numbered communication port in the selection 

box.

9. The communication port list is built during the F1LVDemo program initialization. 

If you connect to the board after the program is started, the communication port 

will not appear in the selection list.
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10. Click the Open button. After the link to the F1 LV Evaluation Platform is estab-

lished, the F1 LV Evaluation Platform software version will be displayed, as well 

as the detected motor type.

When the link is established, all user accessible motor parameters stored in the add-on 

board will be retrieved and shown in the corresponding controls of the GUI. Controls 

not applicable to the detected motor will be disabled and grayed out. 

1.4.5 Open Versus Closed Loop

The open-loop and closed-loop selections apply only to brushless DC and stepper 

motors. In open-loop operation, the motor voltage and speed controls are independent. 

In closed-loop operation the speed control functions as the control for both the speed 

and voltage. 

Brushless DC is truly a closed-loop operation where the applied voltage is set with the 

speed control and the motor speed responds automatically to keep the back EMF 

voltage equal to the applied voltage. 

Stepper motor closed-loop operation is technically not closed loop. Both the motor 

voltage and speed outputs simultaneously follow the single-speed control input as 

independent open-loop functions of the minimum and maximum speed and drive 

parameters.

1.4.6 Changing Motor Parameters

To change a motor parameter, type the new value into the corresponding text box. The 

initial key press clears the previous value and changes the value to red. Red indicates 

that the value has not been sent to the Platform RAM. When the enter key is pressed 

the value is immediately sent to the Evaluation Platform RAM and the display returns 

to the default black. The entry can be terminated without updating the Platform RAM 

by pressing the Escape key. Changed parameters reside in volatile RAM only. Any 

Platform Reset will restore the RAM values to those in the Platform EEPROM memory. 

Unexpected Platform Resets will cause inconsistencies between the parameters 

displayed in the GUI and those in the Platform RAM. Select the pull-down menu 

File->RAM->Display option to resynchronize the displayed values with those in the 

Platform RAM. 

1.4.7 Saving and Restoring Motor Parameters

Sometimes it is useful to try many different motor setups when optimizing performance. 

Setups can be saved to disc storage with the pull-down menu File->Save… option.

Previously stored setups can be recovered with the pull-down menu File->Open… 

option. Parameters retrieved from disc update both the display and the Platform RAM.

When the optimum setup is determined those parameters can be saved to the Platform 

nonvolatile memory with the pull-down menu File->RAM->EEPROM option. 

Parameters saved to EEPROM will be restored to RAM on every Platform Reset. The 

values in the Platform EEPROM can be restored to RAM without a Reset with the 

pull-down menu File->EEPROM->RAM option.

The EEPROM can also be restored to the factory defaults with the pull-down menu 

File->Defaults->EEPROM option. The factory defaults can be altered only by changing 

the source code and programming the Platform program memory after recompiling the 

source code.
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1.4.7.1 CATASTROPHIC RECOVERY

In the unlikely event the UNI/O memory becomes erased or damaged, the memory can 

be completely restored with the File->Restore->(add-on type) option. This option 

should only be used if the add-on board fails the automatic detection process. Take 

care to select the add-on type corresponding to the attached board. Failure to do so will 

cause unexpected operation possibly resulting in permanent damage to the add-on 

board hardware.

1.4.8 Hints for Optimum Performance

The BLDC and stepper motors are interrupt driven. The motor commutation interrupts 

take precedence over all other operations. All services other than the motor commuta-

tion are polled. When the motor is operating at very rapid commutation rates, the time 

for other services can become severely limited. For most situations, the serial link ser-

vice is able to keep up with the activity from the PC. However, when a rapid series of 

commands is coupled with rapid commutations, the serial link can appear to stall. To 

avoid this situation, use the slider controls for only small and slow changes. Enter num-

bers directly into the slider text box when a large change to the slider control is desired. 

If a stalled control condition occurs, try to regain control by clicking on the red STOP 

button. If that does not restore control, the last resort is to press the F1 LV Evaluation 

Platform MCLR button.

1.4.9 Header File Versus GUI Motor Parameters

The default motor parameters are defined in the F1 LV Evaluation Platform source code 

motor header files. The following table correlates the GUI parameters with the equiva-

lent header file parameters. The conversion factor is the value by which the header file 

parameter is multiplied to derive the GUI parameter. In all cases, whether in the table 

or text, parameters expressed as all caps may be found exactly as shown in the header 

files.

See Appendix B. “Conversion Factors” for more information on the parameters and 

the associated conversion factors. 
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TABLE 1-2:

Motor Type GUI Parameter Header File Parameter
Conversion 

Factor

BLDC

(EBM)

Start-up: Percent Drive MED_START_DRIVE_PCT 1

Start-up: Speed (RPM) START_RPM 1

Poles NUM_POLES 1

Blanking BLANKING_COUNT_us 1

Slow Step TIMEBASE_SLOW_STEP 10

Open Loop OPEN_LOOP_ms 1

Stall STALL_COUNT_us 1

Run Percent LOW_RESTORE_REQUEST_PCT 1

Stop Percent LOW_OFF_REQUEST_PCT 1

Error Scale ERROR_SCALE 1

BDC

(PAN14)

Run Percent LOW_RESTORE_REQUEST_PCT 1

Stop Percent LOW_OFF_REQUEST_PCT 1

Unipolar

(42HS03)

and

Bipolar

(39HS)

STEPPER

Run Percent REQUEST_ON 0.392

Stop Percent REQUEST_OFF 0.392

Min. Duty Percent MIN_DUTY 0.392

Max. Duty Percent MAX_DUTY 0.392

Degrees per Step MOTOR_STEP_ANGLE 0.1

Max RPM MAX_RPM 1

uStep Table Bipolar_CCP_Val[]

Unipolar_CCP_Val[]

Varies
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Chapter 2.  The BLDC Add-on Board

2.1 OVERVIEW

The BLDC add-on (DM164130-2) allows you to drive virtually most sensorless 

three-phase brushless DC motors used in consumer electronics, ranging from small 

HVAC applications to complex media reading/writing drives. The add-on is shipped 

together with the ebm-papst BLDC motor, to which it connects through a ribbon cable 

to a special connector on the board (J5). Alternatively, any other 5-12V BLDC motor 

can be used by hooking it up through the J2 connector.

2.1.1 Features

The key features of this board include the following:

Connectors:

� Male 20-pin connector (J1) to match the F1 LV Evaluation Platform

� Generic 6-pin BLDC motor connector (J2)

� 6-pin ebm-papst motor interface (J5)

� 5-12V power supply input connector (J4)

Typical BLDC drive:

� Three P-type and 3 N-type MOSFETs forming three half bridges for the three 

motor phases

� Six bipolar transistors to command the MOSFETs

� Sensing resistor for current measurement (R15)

Control:

� R21 for adjusting the zero crossing voltage

� R19 for adjusting the over-current Fault detect (software for this function is not 

implemented).

Protection: 

� Power fuses (F1, F2)

Power supply:

� 3.3V voltage regulator (U1)

2.1.2 What’s Included

The BLDC add-on part number (DM164130-2) contains:

� BLDC Add-on Board designed for the F1 Evaluation Platform

� ebm-papst motor (P/N: VD-3-25.07)

� 28 AWG ribbon cable to match the ebm-papst motor

Note: The function labels on these two controls are reversed on the R2 revision 

of these boards.
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2.1.3 Reference Documents

This section points you to technical application support.

AN857, ”Brushless DC Motor Control Made Easy”

AN885, ”Brushless DC (BLDC) Motor Fundamentals”

AN899, ”Brushless DC Motor Control Using PIC18FXX31 MCUs”

AN970, ”Using the PIC18F2431 for Sensorless BLDC Motor Control”

AN1305, ”Sensorless 3-Phase Brushless Motor Control with the PIC16FXXX”

You can obtain these reference documents from your nearest Microchip sales office

(listed in the last page of this document) or by downloading them from the Microchip

web site.

2.2 BOARD SETUP

A step-by-step connecting procedure is available in Section 1.4.3 “Connecting the 

F1 LV Evaluation Platform to the Add-on Board”. If using the ebm-papst motor, 

attach the ribbon cable from the motor at step 2. Also, make sure that POR R4 on the 

evaluation platform is turned fully CCW.

If using a different motor, connected through J2, please keep in mind to attach each 

motor phase firmly to the connector. The red connector supplied with the board is 

designed to accept 22 AWG wire. Bad contacts can damage the add-on and will wear 

out the motor in time. There is no rule for attaching a specific motor lead to a phase line 

on the add-on. Keep in mind the correspondences on the software side when testing 

or measuring directly on that motor phase.

Adjust R21 90 degrees CCW from the mid-point CCW when operating the ebm-papst 

motor. R21 should be set to its mid-point for other motors.

2.3 HARDWARE

2.3.1 General Architecture

The BLDC add-on uses a typical three half-bridges control configuration suitable for 

three-phase BLDC motors, using six MOSFETS commanded through six bipolar 

transistors. Sensorless control is done in the software without any other external 

components.

Figure 2-1 provides a simplified block diagram of the development board hardware, 

coupled to the F1 LV Evaluation Platform:

WARNING

The BLDC Motor Control Add-on Board is intended to drive three-phase brushless DC 

motors. Before connecting the motor, make sure the power rating of the motor is equal 

to or less than the power rating of the board, as shown in Appendix B. “Conversion 

Factors”. Also, make sure the configuration parameters inside the software or the GUI 

are correct for the motor you are using. Failure to comply with this warning could lead 

to malfunction of the board and the motor, and could result in physical harm.

Before beginning the start-up procedure, complete a visual check of the board and the

motor for connectivity and mechanical damage. If damage is found, DO NOT power-up

the board. Otherwise, you may further damage the equipment. Contact Microchip’s

local office or distributor immediately.
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FIGURE 2-1: THE BLDC MOTOR CONTROL ADD-ON ARCHITECTURE

2.3.2 Attaching the Motor

The BLDC add-on kit includes the three-phase 24V ebm-papst motor. This motor can 

be attached through a dedicated 28AWG 8-wire ribbon cable using connector J5.

FIGURE 2-2: THE EBM-PAPST MOTOR CONNECTOR

However, you can use your own three-phase BLDC motor by attaching its leads to the 

J2 connector. The red connector supplied with the board is designed to accept 22 AWG 

wire.

2.3.3 Power-Up

Voltage is supplied through the 2.5 mm jack connector J4, with a maximum rating of 

+12 VDC. The F1 LV Evaluation Platform should be configured to use expansion board 

power by inserting the power jumper on J6. See the “F1 LV Evaluation Platform for 

Enhanced PIC® Microcontrollers User’s Guide” (DS41614A) for more details.

2.3.4 Power Stage

The BLDC add-on incorporates the classic three half-bridges drive made from P and 

N-type MOSFETs (for more details, please refer to the BLDC board schematic in 

Appendix A. “Board Layout and Schematics”). The maximum current rating is 8A 

on each MOSFET. Please keep this in mind when designing your application or 

modifying the add-on hardware. 

The stage contains six PWM (HU, LU, HV, LV, HW, LW) inputs and three back EMF 

sense outputs (VU, VV, VW). The BLDC motor attaches to the three driver outputs (U, 

V, W). 
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Motor current is measured by using the R15 shunt resistor, placed in-between the 

Power Stage lowside and ground, and connected to the PIC16F1947 through the J1 

connector. (Current sensing is not implemented in the F1 LV Evaluation software.)

2.3.5 Protection

Two 5A fuses (F1 and F2) are used to protect your add-on in case of an overcurrent 

situation in the output drivers. In case one or both of them get burnt, remove power 

immediately from the board and inspect the add-on for further damage. Do not replace 

the burnt fuses with other values than the ones provided with the board.

2.3.6 Speed Control

Speed control can be performed through either the Motor Control GUI or the 10K POT 

R4 located on the F1 LV Evaluation Platform. 

2.4 DEMO SOFTWARE

2.4.1 Introduction

The F1 LV Evaluation demonstration program uses a single combined demo. The 

combined demo source code is organized into sectional code for ease of 

accommodating several motor types. This chapter provides an overview to the 

functions provided by the BLDC demo.

The BLDC demo code is designed to operate a sensorless BLDC control. The software 

can be easily tuned to the needs of your application or motor by changing the 

parameters on-the-fly, by modifying the motor parameters in the F1LVDemo GUI.

2.4.2 The Motor Control GUI Application

Using the Motor Control Application GUI, you can change the following parameters:

� Motor poles number

� Speed [arbitrary range 0 to 255]

� The timing balance between zero-cross and commutation periods [degrees]

� Phase advance [degrees]

� Start-up speed [arbitrary range 0 to 255]

� Drive voltage [% of full scale]

� The minimum blanking period [us]

� Dwell timings: closed-loop slow stepping [ms] and open loop [ms]

� Run/stop hysteresis drive voltage [% of full scale]

� Minimum motor stalling period [us]

� Error scaling factor [divisor power of 2].

Also, the motor can be run in open/closed loop and forward/reverse.

Clicking on the ‘RPM’ text in the Operate tab will display the motor speed in the text 

box next to it.
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2.4.3 BLDC Parameter Optimization

Brushless motors depend on the software to commutate the motor. The software must 

determine the rotor position relative to the stator so as to commutate the driver circuitry 

at specific rotor positions. The rotor position is determined in sensorless motors by 

voltages induced into the stator by rotor motion. The induced voltage is referred to as 

back EMF or BEMF. When the rotor is stationary, there is no BEMF from which to 

determine the rotor position. Starting the motor requires commutating the motor blindly, 

without the benefit of feedback, to start the rotor in motion fast enough to sense the 

BEMF, and close the loop on rotor position for commutation.

The motor speed, in response to the applied voltage, varies by motor design. We need 

to match the initial drive voltage and open-loop commutation rate to the motor to 

accomplish two objectives:

1. prevent excessive current in the motor

2. start rotation fast enough to sense the BEMF

When the motor is running, the BEMF on the driven pair of stator windings matches the 

applied voltage. The BEMF on the undriven winding starts at one power rail at the 

beginning of the commutation period and ends at the other power rail at the end of the 

commutation period. However, this is only true when the motor is running at the design 

speed. At any other speed, the BEMF is effectively undetectable. Unfortunately, the 

motor will not start if we apply a voltage, and then commutate at the rate for which the 

motor is designed. To start the motor, we need to commutate slower than the design 

rate and then ramp up to the design speed.

The task of motor optimization is to find a combination of applied voltage and 

commutation rate for which the motor will start to rotate. From there, the control 

algorithm will ramp-up the commutation rate to where the BEMF can be sensed. The 

Motor Control GUI enables us to independently set the applied motor voltage and 

commutation rate to find a combination that works. Use the following steps to 

experiment with your motor optimization:

1. Set POT R21 to middle range for your motor or 90 degrees CCW from the middle 

range for the ebm-papst motor supplied with the BLDC Add-on Board.

2. Select Open-Loop mode.

3. Set the speed control to a nominal rate, such as 100.

4. Slowly increase the % Drive control until the motor starts to turn.

5. Slowly increase the speed control until it is just faster than the motor can go.

6. Slowly reduce the speed control until the motor starts to rotate again.

7. Note the % Drive setting, then enter 0 into the % drive control text box.

8. Re-enter the % drive setting noted in step 6, and observe that the motor starts 

spinning.

9. Repeat steps 7 and 8 to verify the motor always starts reliably. If it does not, then 

reduce the speed control slightly and repeat steps 6, 7 and 8.

10. When you are satisfied with the start response obtained by steps 6, 7 and 8, then 

enter the final speed control value into the Speed Start-up value text box. The 

equivalent RPM will be displayed.

Note: The displayed RPM value is only accurate if the motor has the number of 

poles indicated. The number of poles only matters if you want the RPM 

value to represent the mechanical operation. If you are not sure how many 

poles your motor has, then you can determine this by leaving the % Drive 

where it is, setting the speed to zero, and count the number of Step button 

clicks it takes to make one full motor revolution. Divide this number by 

three, that is the number of poles.
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